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Allowable Use of Link2CHOP

CHOP takes the privacy and security of a patient's medical
information very seriously.

Use of Link2CHOP is conditioned on the user’s compliance
with CHOP's Policies and Procedures and with all federal
and state law regarding the privacy and security of patient
information such as HIPAA.

A user is only allowed to access an individual patient's
information in Link2CHOP when there is a physician-
patient relationship resulting in the need to access the
patient’s information in order to treat the patient.

Access to information in Link2CHOP is permitted only by
users at the Practice who have Link2CHOP credentials.
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Prohibited Use of Link2CHOP

Viewing information of any patient in Link2CHOP for a
purpose unrelated to treatment of the patient by the practice
including, but not limited to:

The purpose of personal curiosity or medical
research.

Viewing information of a patient who is a family
member, relative, neighbor, co-worker, friend,
celebrity or any other individual not treated by the
Practice.

Allow a contractor or agent of the practice to access
Link2CHOP without the express written agreement of
CHOP.

Compile and/or distribute analyses to third parties
utilizing any data, including de-identified data
without the express written agreement of CHOP.

Use or disclose information in Link2CHOP in any
manner that would constitute a violation of federal or
state law.

6 Link2CHOP Privacy



Role of Site Privacy Officer

Assist CHOP in confirming that a treatment relationship
exists between the practice and patient for records viewed
via Search All Patients (aka: First Access).

Assist CHOP in investigating any potential unauthorized
access or disclosure of PHI obtained from Link2CHOP portal
by practice staff.

Ensure the practice takes appropriate disciplinary and
corrective action as required by HIPAA if staff at practice
access or disclose information obtained from Link2CHOP for
a purpose unrelated to the patient’s treatment by the
practice.

Ensure all staff given access to Link2CHOP have received
HIPAA privacy and security training from the practice
regarding their responsibilities and the practices policies and
any training required by CHOP.

Where appropriate, coordinate with CHOP in providing
written notification to patients in the event of a data breach
involving Link2CHOP portal data and practice staff.
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Getting Started

Link2CHOP is a tool that provides real-time Web access to
patient information, so you can access patients' clinical data
and communicate with CHOP to provide quality patient
care.

Link2CHOP is comprised of different Web pages, or
activities, that correspond to different tasks. The activity that
you use depends on what you want to accomplish. For
example, if you want to see detailed information about a
patient's lab results, you can use the Results Review activity.

This guide takes you on an introductory tour of Link2CHOP.
The first few pages include information to help you get
started, such as browser requirements and how to log in.
The rest of the guide contains explanations of how to use
Link2CHOP. Terms that appear in italics throughout the
guide are further defined in the glossary at the end of the
guide.

Help and contact information

For help using an activity, click “* on the Web page.

If you have issues logging in - please call the Help Desk at
215-590-HELP.

8 Getting Started



Browser, system, and connection requirements

You must use one of the following Internet browsers to
access Link2CHOP:

Apple Safari

Google Chrome

Microsoft Internet Explorer 8.0 or above
Mozilla Firefox 10 and any later versions

Please note the Internet browser requirements:

e Google Chrome version 118 or later. Previously,
version 106 or later was supported.

e Microsoft Edge version 118 or later. Previously,
version 106 or later was supported.

e Mozilla Firefox version 115 or later. Previously,
version 102 or later was supported.

e Safari version 17 or later. Previously, version 15 or
later was supported.

Link2CHOP requires a minimum screen resolution of
1024x768 pixels. While you can use a dial-up Internet
connection to access Link2CHOP, we recommend that you
use a high-speed Internet connection to achieve the best
system speed and performance. In addition, you need Java
enabled to display graphs and scanned images in
Link2CHOP.
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How do | log in?

Open your Web browser and access the following URL:
link2chop.chop.edu

You should automatically be logged in via Azure SSO.

LINK2CHOP 3
GH S:‘ ‘.l%?fa"é‘..’.‘,‘r’.’:“" ) o Password ﬁ
t v Iﬁ
@ -
oo Login
-
Forgot password?
Request New Account
LINK2CHOP
CH sramime™ -
> -

s
-

0

ACCEPT

CANCEL

Select the correct login department and click “Accept”.

You are now logged in to Link2CHOP.

* IMPORTANT: Your account will be disabled after 180
days of inactivity. Please call 215-590-HELP to reactivate
your account.
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https://link2chop.chop.edu/

Navigating in Link2ZCHOP

When you log in to Link2CHOP, two sets of navigation tools
appear at the top of the page.

e Action Options: These buttons allow you to perform

basic tasks, such as selecting a patient or logging out.
Navigation Tabs: These tabs allow you to navigate to
different activities in Link2CHOP.

Most activities are located under the Patient tab. When you
mouse over Patient, a menu appears with activities that you

can select.

11 Gefting Started



Link2ZCHOP Home Page

The Link2CHOP Home Page is the first screen you will
access when logging into Link2CHOP. In addition to the
Event Monitor that displays on this page, updates,
documentation and hyperlinks to access the CHOP intranet
are available for easy reference.

In the News...

The In the News section provides updates on new features
available in Link2CHOP and general announcements.
Please refer to In the News to obtain updates relating to
Link2CHOP.

Quick Links
Quick Links provide a one-click solution for accessing
external websites or finding training documentation.

The following information is available via Quick Links:

¢ Online Training Modules — Provides access to online
training modules relating to Link2CHOP. The
following training modules are currently available:

v Login and Navigation
v Order Entry
v" Create a Patient

e Tip Sheets — Provides training documentation relating
to Link2CHOP.

e External Websites — Easy access to CHOP’s internet
sites.

e Consent Form — Copy of the HIE Authorization form.
(See Health Information Exchange Authorization for
additional information.
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How do | log out?

To maintain patient confidentiality, you need to log out or
secure screen when you are done working or have to leave the
computer for any reason. There are two ways to do this:

e C(lick w9° Log Out to log out of Link2CHOP. The next
time you log in, you are directed to your start page.
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Password Reset

If you need to reset your Link2CHOP password - please call
the Help Desk at 215-590-HELP and a ticket will be created

on your behalf .
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Accessing the Patient Chart

There are two ways to access a patient's chart: by selecting
the patient from a list of your current patients or by
searching for your patient based on name, date of birth, or
other criteria. Both methods are described below.

Select your patient's chart from a list of current patients

If you have access to only a few patients, selecting your
patient from a list is quicker than searching for them.

1. Select the Pt Lists tab. Use the tabs at the top of the
activity to select the patient list you want to view.
2. (lick a patient's name to open their chart.

My Patients

To see only the patients for whom you are the PCP,
select your name in the Filter by PCP field.
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Search for a patient's record based on name or MRN

If you know specific information about a patient, such as his
name or MRN, you can use Patient Lookup to enter the
information and then select the appropriate patient from the
list of possible matches.

1. Click Patient Patient. The Patient Search activity opens.

2. Enter the name of the patient in the Name or MRN field.

3. Press Enter to select the patient’s name from the drop-
down list of potential matches.

4. In the Search Results window, click the name of the
patient whose chart you want to open.

m Searth My Patients
Nama or MRK Dseath
My Patients
F Ternp Syl A
R e 1411 7008 ]
3015006 Al L L M
i e S 2502 F
AR e Ky 1]
1E1A54R Hivr [T W
J01EMs Al 20T F W
'& Search Al Patients

e
I Create a New Chart

In two clicks, you can quickly open a patient chart that
you recently had open. In the Patient Lookup activity, select
the Recent Patients tab and then click the name of the
patient from the list.
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What if | can't find a patient?

If you do not find a patient using the methods above, you
might be able to search for the patient's chart by entering
more identifying information about the patient. Use this tool
when you need to gain immediate access to a patient's chart
for the first time.

® You must enter the patient's full name when using this
method.

1. In the Patient Lookup activity, click Search All Patients.

2R Scarch My Patients

A search All Patients

Please fill
numbser

B Croste o New Charl.

2. Complete all of the required fields, and then click
# Search. The Search Results page appears.

3. Select the patient record you want to review. The Patient
Select Confirmation screen displays.

4. Select the reason you need access to the patient's chart in
the Reason field. Enter additional information in the
Comment field. Click ¥ Accept.

= [Tl SEM
wrinale 1/3/2001 e ]

Frhusras
g S =A S [=10 5S (He ]

Fatient Frogloyrment

Mot Employcd

o Feancn = B o mens

s Eari
< >
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Patient-Provider Relationship for Link2CHOP users

To have access to CHOP patient information as a
Community Physician, you must be a Primary Care
Provider, Admitting, Attending, Referring Provider, or
otherwise be part of the patient's Care Team. The Care Team
being a group of health care workers and support staff, who
are members of different disciplines, each providing specific
services to the patient.

If you are the Primary Care Provider, access to your patients
will never expire. If you are an Admitting, Attending, or
Referring Provider, or a member of the patient's Care Team,
access will expire after 180 days. Patient-Provider
Relationships are created when a patient is registered at
CHOP. In the event that this information is unknown or
incorrect, CHOP will allow you to access a patient's record
for 10 days by using the ‘Search All Patients” functionality.
All 'Search All Patients' requests are reviewed, and when
deemed appropriate, the length of access is updated
accordingly.

The Search All Patient functionality is taking place of the
functionality formerly known as First Access.
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Health Information Exchange Authorization

CHOP is required to obtain a patient’s and/or parent’s
signature, authorizing the release of electronic medical
information. If you attempt to view a patient’s chart, and
are presented with the following message, an authorization
is not on file.

We are sorry, you cannot acoess this record at this time because we do not have a signed consent form from the patient/parent/quardian to provid caregivers electronic access to
medical records. There are several reasons that you might be getting this message:

1. We da not have a signed consent form from this patient to authorize the release of electronic medical records. This could happen in the event that the patient, parent or
quardian wes not available to provide consent, we are in the process of getting consent, or we have not yet had the cpportunity to et consent from this pafient

2. Your patient has daclined consent to give aceess to their slecironic medical record.

You can download the consent form by clicking the link below. Have the patientiparentiguardian sign the form and fax, along with a cover sheet, to 844-FAX-CHOP (844-320-2467).
Aceess to pafient informafion will be: available within 72 hours of receipt.

Links
1

If you need acczss to this information sooner than the above process allows, please contact the division or the depariment directly, or call 1-800-Try-CHOP (1-800-879-2467), Option
A link to a PDF version of the Authorization Form can be
downloaded directly from the Care Filter Report page. The
table below provides details on the required signatures:

Patient Age Signature Requirements
Age(0-12 Parent Signature Only

Age 13 -17 Both Parent and Patient Signatures
Age 18 & Above Patient Signature Only

Fax the completed form to 844-FAX-CHOP (844-329-2467).
Allow up to 72 hours for access to be given.

For immediate access, contact the division or department
directly, or call 1-800-Try-CHOP (1-800-879-2467), Option #2.

Referral orders can be entered without an HIE Authorization
being on file. See the Placing Orders section for additional
information.
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Event Monitor allows you to monitor events that occur in
your patients' care, such as inpatient admissions or
discharges, completion of outpatient visits, or new lab
results. You can view these events on the Welcome page in
the Event Dashboard or in your In Basket.

View recent events that have occurred in the care of
your patients

Select the Home tab. The Event Dashboard appears in the
middle of the page, showing recent events for your patients.

If necessary, you can view more information about events by
clicking the name of the patient in the Patient column. This
takes you to In Basket, where you can view additional
information about the event and mark it as Done if you are
finished reviewing it.

7]
]

Welcome to Link2CHOP

LI N KZ C H O P Event Monitor (Change Settings) s

Outpatient Notifications

U Children’s Hospital Enc
. i Priority ~ Status  Patient Event Type Visit Date
" | of Philadelphia s e Department
Iwant to... Read Williams, Appointment Checked-  03/22/2018  Neurology
Sutesting In
& select a patient
New  Williams Appointment Scheduled  03/22/2018  Neurology

[ Pplace an order I
Sutesting

In the News...

Mo-Show Event Notification

A new event notification has been added to alert you when a patient
‘no-shows' for a scheduled CHOP appointment. For most users, you will
automatically receive the No-Show notifications. Please refer to the
document in the Tip Sheet section, Modifying Event Notifications, to
make changes to the default setup.

Receiving Messages in Link2CHOP

The Link2CHOP In Basket “email” system is for receiving messages only.
For urgent medical matters, please use other methods of
communication.
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Select a patient's chart from an event message

Select the In Basket message for the patient's event and click
i Select Patient to access the patient chart.

Search for specific patient events

1. Select the In Basket tab, and then click ~ Search in the
toolbar.

2. In the Message Types section, select the types of event
notifications for which you want to search.

3. In the other sections, select the other criteria for your

search, such as the message status or priority, and click
/ Search.

A*Search Results' folder will be created and the resulting messages will be listed in the
individual message type subfolders. Out Basket messages are excluded from the search

Patient pe, )
rInBaskets MAll ~Message Types  Mal Statuses  MAl
My In Basket VI0Cd Charts ¥iNew
WIED Netifications YRead
W Inpatient Nofifications ¥ipend
1 New Patient Notifications ¥ Pastpone
¥ Outpatient Notifications ¥ Done
Vi Result Notifications
~Message Recipients WAl —Priorities Ml
7 LINK2CHOP, PHYSICIAN ¥ High
¥ Routine
Milow
rDate Message Received ~ indlude future dates v

o Search X Cancel
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Review your patient's chart before the visit

1. Access the patient's chart from your Patient List or by
searching using the Patient icon. The Patient Snapshot
opens.

2. Select the Chart Review activity.

3. At the top of the page, click the tab that contains the
information you want to see. For example, if you want to
view information about the patient's visits, click the
Encounters tab.

4. To view more details on a row of information, such as a
specific patient visit, click the date hyperlink that appears
in the row. The Report Viewer page opens.

Tip: To view details on several rows at once, click the check
boxes in those rows and then click Start Review.

. i
Chart Review - woozes: fiksred soorc e P @ 0
Encounters | sty Iragng Procecmes OtherObs  Wadatons et Mo Mede Wichepas 108 [peode
Auankein & zherr Feies » widesddivas Elivooreripeet
Filtees: Hde 432" Vss
3| Wher v e L35 Lege st S92 Poider  LEcoigmr ke o
\neaming Vs
Jd Wk B dpparhmert Tpet IRCTE Lk plray
REATLN
AN
Reacnt Visits
| e B dppartmet Ot Cigede R, Gy
N e GhF
| MUY b OMcavisit o el R, Gty
Vi so G
n| W & Offes vigt e (emuss  Gorwsl Sewrk v
Fam T asen L -
Lol b @ LDRTOCS 20 fergiil Llaleibrel sefatumlran 0 0 Fflatin danke
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Find information quickly in the patient's chart

For patients with large charts, it can be helpful to narrow
down the list of visits, labs, medications or other information
in Chart Review. For example, on the Encounters tab, you
can filter the list so you see only the visits associated with
certain providers.

1. In Chart Review, select the tab that contains the
information you want to see (for example, Encounters or
Labs).

2. Click ¥ Filters. The Filters page opens.

3. Select the check boxes next to the values that you want to
see. For example, choose a specific specialty or provider.

4. Click ¥ Apply. The results of your search appear.

5. To remove the search criteria and begin a new search,
click & Clear AllL

@ =g )

Filters ol O el Carplin #n Las Cate A
B Al T ikdarin] %an : LG
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Data Available via Care Everywhere

The Care Everywhere activity is a read-only activity that
allows you to view data obtained from a non-CHOP

organization.

1.

In Clinical Review, select the Care Everywhere activity.
The Care Everywhere Outside Records screen will open.

The Care Everywhere Activity lists each document that
has been received from an outside organization.

» A mortar and pestle icon in the M column indicates
that medications were ordered or discontinued
during this visit.

» A test tube icon in the L column indicates that lab
tests were ordered or resulted during this visit.

* An x-ray icon in the I column indicates that imaging
or EKG orders were ordered or resulted during this
visit. Note: Care Everywhere does not send images.

Select the check box next to a document and click
Review. Note that the document status column
indicates the status of the request for a document:

» Green Circle: The document has been requested and
received.

» Yellow Circle: The document has been requested
but not yet received.

» No circle: The document has not been requested.

To see more information about the organization that
supplied a document, including the date of the last
request, select that document and click Doc. Source
Info.
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View data in graph or table format via Flowsheet

Use Flowsheets activity in Clinical Review to see how patient
data such as vital signs or lab values have changed over
time.

1. Enter a flowsheet template in the Select a Flowsheet: box.
You can use the magnifying glass to search for available
templates. You can also enter a search work in the field
to locate matches. (Example: Enter “lab” to display
templates that contain the word “lab” in the title.)

2. Select the table cells that contain data that you want to
graph.

3. Click 4 Line Graph or [ Bar Graph to create a graph
of the selected data.

Graph [BarGraph W Refresh 3% Legend

=Ta BT O 17 S - COMPREHENSIVE x [ Dates in: @ Columns C Rows

11212018 211512018 3112018 3/29/2018
BPSite  RIGHT ARM

BP 120/80 99/66
Systolic 120 9
Diastolic 80 86
Sys BP %ile 9 59
Dias BP %ile 89 8
Pulse g8
Temp %84 1013
Resp 20
Weight (kg) 041kg 4445kg 2041kg
Weight (Ib) 45lbs  9Blbs 451bs
Height (cm) 1143 em Oem 121.92cm  11684cm
Height (in) 45in 48in 46in
Height Position Standing
Head Cir Oem Oem Ocm Oem
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View a patient's lab results

In addition to lab flowsheets, you can view patient lab
results over time in Results Review. View the patient's
results for labs, radiology, and more.

1. Select the Clinicals tab and click Clinical Review >
Results Review. The Date Range Wizard appears.

2. Select the date range for the results data you want to see
and click ¥ Accept. The patient's results appear.

3. To view a specific result component type, such as
Hematology, or a specific result component, such as
Hemoglobin, expand the tree on the left side of the page.
Select the name of the component or component type
that you want to view. Only those results appear in the
table.

4. To view more columns of results, click 4 Load More. To
view all columns of a patient's results for the time range
that you selected, click ¥4 Load All

[ElHide Tree E-ShowRefRng MdLoad Al 4 LoadMare @ TimeMark & Refresh 88 Legend i Options

View, | Condensed View v 1 Hide data prior to: | 10/2/2017 Use Date Range Wizard

Select penent; GROUP COMPONENT (W/O NORMALS)  DATA

OTHERS Amylase 129" 4 11/11/2016 3:22:00 PM

Amylase 129* 4 11/11/2018 2:22:00 PM
Amylase 129* & 11/11/2016 3:22:00 PM
Amylase 129* & {1/11/2016 3:22:00 PM
Amylase 129* & 11/11/2016 3:22:00 PM

Collapse
= MICROBIOLOGY & VIROLOGY
# GENERAL MICROBIOLOGY  #
# POINT OF CARE
= GENETICS
B IMMUNOGENETICS
= RADIOLOGY
H DR
F MR
# Us
=l OTHERS
Amylase v

Time mark results so the next time you view the
patient's results, you can easily distinguish any new results

from those that you have already seen. Click @ Time Mark
to do so.

26 Monitoring Your Patients



Customize the way results appear

1. In Results Review, click = Options.

2. To make the most recent results appear from left to right
by default, select the Trend Dates in reverse
chronological order check box.

3. Set your other default preferences, such as the default
number of columns to show, using the other options.

4. Click ¥ Accept.

View a patient's allergies

Select the Clinicals tab and click Clinical Review >
Allergies.

3) View History  ® Medication Warnings & Refrest
Reactions Severity

O Latex Anaphylaxis High 1/11/2017
O Peanut Anaphylaxis High 11/29/2016

Last Reviewed by Lawten, L Gregory, MD on 2/28/2018 at 11:49 AM: Assessed/Confirmed

For more information about an allergy, select the option
button next to the allergy and click ==l View History.
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View a patient's current medications

Hover over the Patient tab and click Medications.

Medications

Current | History (Inpatient) History
< Refresh 38 Legend
Current Prescriptions

B W Medication Sig Disp Refils

Testingukiah60 ~ 15mL 1
ordered

Take ONE tablet(s) 7 tablet 0

(10 mg total) by ©) ordered
mouth at bedtime

for 7 days. Take 1

pill daily at

bedtime

L (1015 Spray1 Fluid 000 1
& gray background indicates a discontinued or expired medication.

Start Date

2/19/2018

1/11/2018

3/6/2018

N ., Noteto D/C . A
EndDate  DAW Phamay  Reason Route Pharmacy

Testing SU ERXTEST

2508 PHARMACY 123
MAIN ST FORT
WORTH TX 76102

1/18/2018 Testing Oral ERX TEST
PHARMACY 123
MAIN ST FORT
WORTH TX 76102

Nasal ERX TEST

Logged n as LINKTOCHO?, PHYSICAN

EpicCare Lk ensed fom Epc ystems Corporation, © 1997 - 2016 i Systems Corporation.
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View a list of the patient's current medical problems

Hover over the Patient tab and click Problem List.

t reviewed by Lawton, L Gregor,

3 Problem History

Show: [IResolved []Deleted

Abscess [L0291]

Developmental delay [R62.50]

Bronchiclitis [J21.9)

Gastroenteritis, acute [K52.9]

Delayed milestones [R62.0]

Priofity  Class Noted Resoly

2/15/2018

11/2/2017

11/2/2017

11/2/2017

11/2/2017

Updated

2/15/2018 Luberti, Anthony, MD

11/2/2017 Crocker, Kathleen, MD

11/2/2017 Crocker, Kathleen, MD

11/2/2017 Crocker, Kathleen, MO

11/2/2017 Crocker, Kathleen, MD

For more information about a problem, select the
option button next to the problem and click | Problem

History.

View a patient's history

Hover over the Patient tab and click Histories. A report
appears with information about the patient's medical,

surgical, family, and social history. Note: Social history
includes topics like tobacco use and sexuality.

For a high-level view of the current patient's chart,

select SnapShot from the Clinical Review menu.

29 Monitoring Your Patients

~



View a patient's demographics

Hover over the Patient tab and click Demographics. A
report appears with demographic information like the
patient's address, PCP, emergency contacts, and more.

Demographics

Basic Demographics

Name MRN SSN Sex Date of Birth
MyChart, Daisy 31015631 r——io Female /3172011 (7 yrs)
Ethnic Greup Marital Status Patient Status

N/A Single Alive

Contact Information

Address Phone E-mail Address
1010 Kitty Drive 267-426-3068 (Home) gorhamt@email.chop.edu
SOUTHAMPTON PA 18966 215-555-1212 (Mobile)

Additional Info
Aliases
MYCHART,CAT

PCP and Center
Primary Care Provider Fhone Center

Anthony Luberti, MD 215-467-5870 CARE NETWORK COMMUNITY RL

Pharmacy Preferences
Pharmacies
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Placing a New Order

You can use Link2CHOP to place referral orders for your
patient to take place at The Children's Hospital of
Philadelphia. Referral orders can only be placed for patients
previously seen at CHOP.

Place a new order

1. Hover over the Patient tab and click Order Entry. The
Order Entry activity appears.

2. Click [B Preference List to see a list of available orders.

3. Select the check box next to each order that you want to
place. These orders appear under Selected Orders on the
right side of the page.

4. Click ¥ Accept Orders. A list of your orders appears.

5. Click an order's name to edit details like associated
diagnoses. Click ¥ Accept when finished.

6. Click ¥ Sign Orders.

7. Enter your password if prompted and click ¥ Accept.

Referrals
Referrals (Procedures) A | Procedures

[0 consult to Adalescent Family Planning - Linkc * Refe W consult ta Audiclogy
Consult to Adolescent Specialty Care - Lin P Referral

[0 consult to Allergy ” eferra

&l

Consult to Audiology - Link2CHOP Referral
Consult to Autism - Link?CHOP Referral
[J  Consult to Cardiology - Link P Refer

Consult to Cerebral Palsy - Link2CHOP Referra

v

[0 Consult to Child Development

+ Accept Orders X Discard Orders

If you already know the name of the order in Link2 CHOP, you
can search for it in the New procedure field.

Referral orders can be entered without an HIE Authorization
being on file. See the Health Information Exchange
Authorization for additional information.

® @O
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You can use the Link2CHOP utility options to perform a
variety of account maintenance tasks, including setting the
page that appears when you first log in. You can also use
utility options to determine your default patient selection
method. A description of each utility appears on the
Utilities page.
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Change your default page

Use the Set Default Page tool to determine which page you
see first when you log in to Link2CHOP. For example, if you
prefer to review your In Basket messages each time you log
in, you can save time by setting your start page to In Basket.

1. Click vils Utils and then click Set Default Page.
Navigate to the page that you want to set as your default
page.

3. Click Set Default Page at the top of the application to set
the current page as your default page.

LINK2CHOP ¥ R

Home  InBasket Ptlists  Clinicals o | Patient Utils Secure  Log Out

(7 1]
(]

Utilities » Set Default Page

Set your default page

You can choose the page that appears by default when you log in to Link2CHOP. If you choose a page which requires
a patient to be selected, that activity will also be used as your default page upon selecting a patient. It will also
appear when you clear a patient.

To set your default page:

Navigate to the page you want to appear by default and dlick the Set Default Page button at the top of the screen.
OR
Click here to clear your default page and use the system settings instead

TiP: To reset your start page to the system default, go to the
Set Default Page utility and click Click here to clear your
default page and use the system settings instead.
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Event Monitor

When a patient event that you have chosen to monitor
occurs, an In Basket message is sent to the appropriate
notification folder.

You may choose event notification preferences in the Event
Setup activity in three sections:

1. Access the Event Settings page by following the path
Utils > Event Settings.

2. Choose which types of events you'll receive notifications
for by selecting the check boxes in the Event Filter
section. To receive notifications for all the available event
types, select the Events I Will Receive check box.

3. Choose which events you'll receive notifications for by
selecting one of the options in the Relationship Filtering
section:

a. Any patients seen by my group. This option
includes events for any patient that you have
access to.

b. Only events associated with a provider in my
group (recommended). This option includes only
events associated with the providers in your
provider group. For example, if a patient you have
access to is admitted to the hospital, but none of
the providers in your group is associated with the
admission, you would not receive a notification.

c. Only events associated with me. This option
includes only events associated with you
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d. Only events associated with certain providers.
This option includes only events associated with
certain providers in your provider group.

4. Choose who your notifications are sent to by selecting
one of the options in the In Basket Settings section:

a. Any user in my group. Your notifications are sent
to a pool at your organization. Any other user in
the pool can access the message and mark it as
Done, which removes it from the In Baskets of all
the users in the pool. This option helps reduce the
risk of duplicate follow-up and can save time.

b. Only me. Your notifications are sent only to you.
This option helps ensure you see every
notification.
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Event Filter @

M Events I Will Receive

Admission

Appointment Cancelled
Appointment Checked-In
Appointment Checked-Out
Appointment Scheduled

Check-In/Out Cancelled

N (L N LY

Discharge
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Relationship Filtering @

Motify me for.

O Al events for patients in my groug

® Only events associated with a provider, depament, vendor, or referra! location/POS in my group irecommended)
O Only events associated with me

O Only events associated with certain providers, departments, vendors, or referral location/P0Ss

In Basket Settings 0

Allow my messages to be handled by:
© Any user in my group

O Only me
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Link2CHOP Glossary

Activity

Any Web page that corresponds to a specific task, such as
selecting a patient, reviewing a patient's results, or creating a
referral. There are several different activities in Link2CHOP,
and the activities that you use depend on the tasks that you
want to complete. Each activity has a name in Link2CHOP,
such as Results Review, that helps you determine the
activity's purpose.

Completion Matching

Entering a partial word in a field instead of a whole word to
reduce the amount of time you spend typing. For example,
entering "vital" and then pressing ENTER in the Select a
Flowsheet field in Flowsheets shows you all of the
flowsheets beginning with "vital." Since it is likely that few
flowsheets have names that start with this letter
combination, it is easy to find the flowsheet without typing
the whole name. You can use this shortcut for any
information that is stored in the database, such as other
providers' names.

Select a flowsheet: i > Search
%6 Flowsheet Name

75.48%

75.48%
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Encounter

One visit with a provider. This might include a visit type
such as an inpatient stay, an office visit, or a telephone call
from a patient. Encounters appear in Chart Review. When
you view an encounter, you can see all of the information
associated with that specific visit, including the patient's
vital signs, progress notes, procedures and medications
ordered during the visit, and more. Encounters are classified
by date, type, and provider.

Event

A clinically relevant business event that occurs for a patient.
Events are recorded in the system at several points in a
patient flow. For example, events are triggered when a
patient schedules an appointment, is admitted to the
hospital, cancels an appointment, has new results, etc. The
urgency of events can vary. For example, a scheduled
appointment for a physical might not be as urgent as an
admission to the hospital.

Field

Any place in Link2CHOP where you can enter information.
Each field has a prompt to indicate the type of information
you should enter, such as Name or MRN.

Name or MRN: |

40 Link2CHOP Glossary



Hyperlink

Text that you can click to access a different Web page.
Hyperlinks appear in several places in Link2CHOP. When
your mouse pointer moves over a hyperlink, the pointer
typically changes to a hand icon and the text of the
hyperlink becomes underlined.

Reason for Visit History

Provider

Any person involved in patient care, such as a nurse, the
patient's primary care physician, or a referring provider.
Patient information in Link2CHOP is often associated with a
specific provider. For example, procedure orders are
associated with the provider who wrote the orders.
Similarly, when you create a referral, you can enter a
referred by and referred to provider.

Recommended field

Information that we recommend you enter. W appears next
to recommended fields. You can continue to save or submit
information if you do not complete recommended fields.

Required field

Information that you are required to enter. (1] appears next
to required fields. You cannot save or submit a form until
you complete all required fields.
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Search All Patients (Formerly known as First Access)

A tool that you can use to open the record for a patient with
whom CHOP does not have you as an established care
provider. This tool might be useful in case of emergencies or
at other times when you might need to access a patient's
record before you've been granted access. The Search All
Patients hyperlink appears in the Patient Lookup activity.
After you click Search All Patients, you are prompted to
enter specific pieces of information about the patient before
you can gain access to the record.

Time mark

Click © Time Mark in the Results Review activity to
indicate that you have seen the patient's new results. When
you do so, the results are no longer considered new to you.
The next time you access Results Review for the patient and
select the New Results View from the View menu, only the
results that have been entered since you clicked © Time
Mark appear. New results appear in italic font, and all other
results that you indicated that you've seen appear in normal
font.
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